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Configuring an Email Account to Access 
Cisco Unity Connection Voice Messages

Cisco Unity Connection allows licensed users to use a third-party IMAP client to access voice messages 
from their desktop machines. You can also forward voice messages with text and reply to voice messages 
with text; the text portion of the message is accessible through the Connection Text to Speech feature.

See the following sections:

• Considerations When Configuring IMAP Email Clients, page 3-1

• Creating and Configuring an Account in Apple Mail, page 3-2

• Creating and Configuring an Account in Eudora, page 3-3

• Creating and Configuring an Account in IBM Lotus Notes, page 3-5

• Creating and Configuring an Account in Microsoft Outlook, page 3-6

• Setting Up Cisco Unity Connection ViewMail for Microsoft Outlook, page 3-8

• Creating and Configuring an Account in Microsoft Outlook Express, page 3-11

• Creating and Configuring an Account in Novell GroupWise, page 3-12

• Creating and Configuring an Account in Opera, page 3-14

• Creating and Configuring an Account in Thunderbird, page 3-15

• Creating and Configuring an Account in Windows Mail for Windows Vista, page 3-16

• Troubleshooting IMAP Client Logon Problems, page 3-17

Note When users change their Cisco Personal Communications Assistant (PCA) password in the Cisco Unity 
Assistant, they also must update the password from their IMAP client application. Passwords are not 
synchronized between IMAP clients and the Cisco PCA. If users have trouble receiving voice messages 
in an IMAP client even after updating their Cisco PCA password in both applications, see the 
“Troubleshooting IMAP Client Logon Problems” section on page 3-17.

Considerations When Configuring IMAP Email Clients
Revised May 2009
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Note the following considerations when configuring IMAP email clients to access Cisco Unity 
Connection voice messages:

• In Cisco Unity Connection Administration, configure the following settings on the System 
Settings > SMTP Configuration > Server page to match the SSL settings in the IMAP email clients:

– Allow Connections From Untrusted IP Addresses

– Require Authentication From Untrusted IP Addresses

– Transport Layer Security From Untrusted IP Addresses Is (Disabled, Required, Optional)

For more information on these settings, see the “SMTP Server Configuration” section in the 
“System Settings” chapter of the Interface Reference Guide for Cisco Unity Connection 
Administration.

• IMAP email clients all include two fields in which you can enter either the IP address or the fully 
qualified domain name of the Connection server. When clustering is configured, enter the fully 
qualified domain name of a DNS A record that includes the Connection publisher and subscriber 
servers. If your DNS server allows you to specify the order in which DNS tries to contact Connection 
servers, specify that the server that is available most often is the first server contacted. This usually 
is the publisher server.

Some IMAP email clients do not respect DNS A records. For those clients, if the first Connection 
server is not available, the client does not try to access the other Connection server.

• When a user forwards or replies to a voice message from an IMAP email client, the message will be 
sent to recipients on the Connection server unless the user specifically configures the message to be 
sent through another account.

See the “Configuring IMAP Settings” chapter of the System Administration Guide for Cisco Unity 
Connection for additional details.

Creating and Configuring an Account in Apple Mail
To use Apple Mail to access Cisco Unity Connection voice messages, create and configure a new Apple 
Mail account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Apple Mail

Step 1 Start Apple Mail.

Step 2 In Apple Mail, on the Mail menu, click Preferences.

Step 3 At the top of the Preferences dialog box, click Accounts.

Step 4 In the lower left corner, click +.

Step 5 In the Account Type list, click IMAP.

Step 6 In the Description field, enter a name for the account. This name appears only in Apple Mail.
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Step 7 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Full Name field, enter the user name.

Step 9 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 In the User Name field, enter the Connection user name.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 In the Outgoing Mail Server (SMTP) field, click the IP address or the fully qualified domain name of the 
Connection server.

Step 13 Click Server Settings.

Step 14 Optionally, in the SMTP Server Options dialog box, check the Use Secure Sockets Layer (SSL) check 
box.

Caution If you do not configure Apple Mail to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

Step 15 In the Authentication list, click Password.

Step 16 Click OK to close the SMTP Options dialog box.

Step 17 Click the Advanced tab.

Step 18 In the Keep Copies of Messages for Offline Viewing list, choose the applicable option.

Step 19 Close the Preferences dialog box.

Step 20 In the Save Changes dialog box, click Save.

Creating and Configuring an Account in Eudora
To use Eudora to access Cisco Unity Connection voice messages, create and configure a new Eudora 
account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.
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To Create and Configure a New Account in Eudora

Step 1 Start Eudora.

Step 2 On the Eudora Tools menu, click Personalities.

Step 3 Right-click anywhere in the Personalities tab, and click New.

Step 4 In the New Account wizard, on the Account Settings page, click Next to accept the default value, Create 
a Brand New E-Mail Account.

Step 5 On the Personality Name page, enter a display name for the account. The value that you enter here is 
visible only in Eudora.

Step 6 Click Next.

Step 7 On the Personal Information page, enter the user name.

Step 8 Click Next.

Step 9 On the E-Mail Address page, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 Click Next.

Step 11 On the User Name page, enter the Connection user name.

Step 12 Click Next.

Step 13 On the Incoming E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 For the type of server, click IMAP.

Step 15 Click Next.

Step 16 On the IMAP Location Prefix page, do not enter a value.

Step 17 Click Next.

Step 18 On the Outgoing E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.

Step 19 Click Next.

Step 20 On the Success page, click Finish to create the account and close the wizard.

Step 21 In the Enter Password dialog box, enter the Cisco PCA password of the user.

Step 22 Click OK.

Step 23 Optionally, configure the new account to use SSL. For more information, see Eudora Help.
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Caution If you do not configure Eudora to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

Creating and Configuring an Account in IBM Lotus Notes
Revised May 2009

Caution If you plan to configure user accounts to use Cisco Unity Connection ViewMail for IBM Lotus Notes, 
do not follow the instructions in this section. Instead, follow the configuration instructions in the Release 
Note for Cisco Unity Connection ViewMail for IBM Lotus Notes, available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

To use Notes to access Cisco Unity Connection voice messages, create and configure a new Notes 
account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

Caution When using Lotus Notes version 7.x to access Connection voice messages, you must first configure 
Notes to connect to a Domino account before configuring the Connection account.

To Create and Configure a New Account in IBM Lotus Notes

Step 1 Start IBM Lotus Notes.

Step 2 On the Notes File menu, click Preferences > Client Reconfiguration Wizard.

Step 3 In the Lotus Notes Client Configuration wizard, on the Additional Services page, check the Internet 
Mail Servers (POP or IMAP, SMTP) check box.

Step 4 Click Next.

Step 5 On the Set Up Internet Mail page, in the Select the Type of Server Used for Retrieving Incoming Mail 
list, click IMAP.

Step 6 In the Enter a New Account Name list, click Incoming Internet Mail.

Step 7 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Cisco Unity Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 Click Next.
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Step 9 On the Set Up Internet Mail page, in the Account Name field, enter the Connection SMTP Address of 
the user and the name of the Connection server. You can find this information in the SMTP Address field 
on the User Basics page in Cisco Unity Connection Administration. The Account Name typically 
follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 In the Password fields, enter and confirm the Cisco PCA password of the user.

Step 11 If you want to encrypt voice messages and other data that are sent between Notes and Connection, check 
the Log On Using SSL check box. If not, skip to Step 12.

Caution If you do not configure Notes to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages that are sent back from 
Connection are not encrypted.

Step 12 Click Next.

Step 13 On the second Set Up Internet Mail page, in the Enter a New Account Name list, click Outgoing 
Internet Mail.

Step 14 In the Outgoing SMTP Mail Server list, enter the IP address or the fully qualified domain name of the 
Connection server.

Step 15 Click Next.

Step 16 On the third Set Up Internet Mail page, in the E-Mail Address field, enter the Connection alias of the 
user and the name of the Connection server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 17 In the Internet Domain field, enter the Internet domain name of the Domino mail server.

Step 18 Click Next.

Step 19 Click OK.

Creating and Configuring an Account in Microsoft Outlook
Revised May 2009
To use Outlook to access Cisco Unity Connection voice messages, create and configure a new Outlook 
account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

In addition to configuring Outlook to access Connection voice messages, you can also install the optional 
Cisco Unity Connection ViewMail for Microsoft Outlook plug-in. See the “Setting Up Cisco Unity 
Connection ViewMail for Microsoft Outlook” section on page 3-8.

To Create and Configure a New Account in Outlook

Step 1 Start Outlook.
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Step 2 On the Outlook Tools menu, click E-Mail Accounts.

Step 3 In the E-Mail Accounts wizard, click Add a New E-Mail Account.

Step 4 Click Next.

Step 5 On the Server Type page, click IMAP.

Step 6 Click Next.

Step 7 Enter values in the User Information section:

a. In the Your Name field, enter a display name for the account. The value that you enter here is visible 
only in Outlook.

b. In the E-Mail Address field, enter one of the following:

• The Connection SMTP Address of the user and the name of the Connection server. You can find 
this information in the SMTP Address field on the User Basics page in Cisco Unity Connection 
Administration. The E-Mail Address typically follows this format:

<alias>@<SMTP domain name of the Connection server or cluster>

• The proxy address for the user.

Step 8 Enter values in the Server Information Section:

a. In the Incoming Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

b. In the Outgoing Server field, click the IP address or the fully qualified domain name of the 
Connection server.

Step 9 Enter values in the Logon Information section:

a. In the User Name field, enter the Connection user name.

b. In the Password field, enter the Cisco PCA password of the user.

c. Verify that the Remember Password check box is not checked. If this option is checked, and the 
Connection password of the user expires, changes, or is locked, Microsoft Outlook does not prompt 
the user to enter the Connection password. The result is that users do not receive voice messages 
from Connection.

Step 10 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook and Connection, skip to Step 15.

Caution If you do not configure Outlook to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook and Connection, 
continue with Step 11.

Step 11 Click More Settings.

Step 12 In the Internet E-Mail Settings dialog box, click the Advanced tab.
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Step 13 Under Incoming Server (IMAP), check the This Server Requires an Encrypted Connection (SSL) 
check box.

Step 14 Click OK to close the Internet E-Mail Settings dialog box.

Step 15 If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to 
Step 21.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses, 
continue with Step 16.

Step 16 Click More Settings.

Step 17 In the Internet E-Mail Settings dialog box, click the Outgoing Server tab.

Step 18 Verify that the My Outgoing Server (STMP) Requires Authentication check box is checked.

Step 19 Verify that Use Same Settings as My Incoming Mail is selected.

Step 20 Click OK to close the Internet E-Mail Settings dialog box.

Step 21 Click Next.

Step 22 Click Finish.

Step 23 In the left pane of Outlook, click the Inbox folder for the new account.

Step 24 On the Outlook Tools menu, click Send/Receive > This Folder.

Step 25 If prompted, enter the Connection user name and Cisco PCA password.

Setting Up Cisco Unity Connection ViewMail for Microsoft 
Outlook

By using ViewMail for Outlook to access Cisco Unity Connection voice messages, users can play and 
record voice messages by using the Media Master. See Figure 3-1.

Figure 3-1 Media Master
3-8
User Workstation Setup Guide for Cisco Unity Connection Release 7.x

OL-17019-01



Chapter 3      Configuring an Email Account to Access Cisco Unity Connection Voice Messages
  Setting Up Cisco Unity Connection ViewMail for Microsoft Outlook
Task List for Setting Up ViewMail for Outlook
ViewMail must be installed on each user workstation. Complete the following tasks to set up ViewMail 
for users:

1. Review the applicable Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook, 
available at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. The 
document specifies the requirements and procedures for installing ViewMail.

2. If you have not already done so, install ViewMail according to the procedures in the Release Notes 
for Cisco Unity Connection ViewMail for Microsoft Outlook.

3. If you have not already done so, configure an IMAP account in Microsoft Outlook. See the “Creating 
and Configuring an Account in Microsoft Outlook” section on page 3-6.

4. If users have more then one IMAP account configured, you must configure ViewMail to use the 
IMAP account that is used to access Connection. See the “Configuring the IMAP Account for 
ViewMail for Outlook” section on page 3-9.

5. If you use secure messaging or TRAP, you must configure several ViewMail settings. See the 
“Configuring ViewMail for Outlook Settings for Secure Messaging and TRAP” section on page 3-9.

Configuring the IMAP Account for ViewMail for Outlook
Revised May 2009
If users have more than one IMAP account configured, you must configure ViewMail to use the IMAP 
account that is used to access Connection. This ensures that messages composed by using ViewMail are 
sent to the Connection server. If users have only one IMAP account configured, ViewMail automatically 
uses it to send messages to Connection.

Do the following procedure on each user workstation.

To Configure ViewMail for Outlook Settings

Step 1 From the Outlook Tools menu, click ViewMail Options.

Step 2 Click the Accounts tab.

Step 3 In the Select the Account to Access Cisco Unity Connection With field, select the IMAP account that is 
used to access Connection.

Step 4 Click Save.

Configuring ViewMail for Outlook Settings for Secure Messaging and TRAP
If you have configured Connection for secure messaging or if you want users to be able to record or play 
messages by phone by using Telephone Record and Playback (TRAP), you must configure several 
ViewMail settings.

After ViewMail has been installed, do the following procedure on each user workstation.
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To Configure ViewMail for Outlook Secure Message and TRAP Settings

Step 1 From the Outlook Tools menu, click ViewMail Options.

Step 2 Click the Server tab.

Step 3 Enter the following settings:

Step 4 Click Save.

Table 3-1 Server Settings

Field Setting

Cisco Unity Connection 
Server Name

Enter the name of the Connection server. (Required for secure messaging 
and TRAP.)

Username Enter the Connection user name (alias).

Password (Optional) Enter the Cisco PCA password of the user. If you do not enter 
the password, the user is prompted for it each time Outlook is restarted. 
If you do not want the user to be prompted for the password each time 
Outlook is restarted, you must also check the Remember Password check 
box.

Remember Password (Optional) Check this check box if you want ViewMail to remember the 
user password so that the user does not have to re-enter it each time 
Outlook is restarted.

Proxy Server Address If you have a firewall that blocks HTTPS traffic between user 
workstations and the Connection server, enter the IP address of the 
HTTPS proxy server.

Proxy Server Port If you have a firewall that blocks HTTPS traffic between user 
workstations and the Connection server, enter the server port to use when 
connecting to the HTTPS proxy server.

Validate HTTPS Certificate If you replace the default self-signed certificate with a certificate from a 
certificate authority, check the Validate HTTPS Certificate check box.

If you are using the default certificate installed with Connection, this 
check box must not be checked.

For details, see the “Securing Cisco PCA and IMAP Email Client Access 
to Cisco Unity Connection” chapter of the System Administration Guide 
for Cisco Unity Connection.

Extension Enter the extension of the user.

This setting is required only if you want the user to be able to record or 
play messages by phone.
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Creating and Configuring an Account in Microsoft Outlook 
Express

To use Outlook Express to access Cisco Unity Connection voice messages, create and configure a new 
Outlook Express account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Outlook Express

Step 1 Start Outlook Express.

Step 2 On the Outlook Express Tools menu, click Accounts.

Step 3 In the Internet Accounts dialog box, click the Mail tab.

Step 4 Click Add > Mail, and the Internet Connection wizard appears.

Step 5 On the Your Name page, in the Display Name field, enter the user name.

Step 6 Click Next.

Step 7 On the Internet E-Mail Address page, click I Already Have an E-Mail Address That I'd Like to Use.

Step 8 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Click Next.

Step 10 On the E-Mail Server Names page, in the My Incoming Mail Server Is a <protocol> Server list, click 
IMAP.

Step 11 In the Incoming Mail (POP3, IMAP, or HTTP) Server field, enter the IP address or the fully qualified 
domain name of the Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 12 In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of 
the Connection server.

Step 13 Click Next.

Step 14 On the Internet Mail Logon page, in the Account Name and Password fields, enter the Connection user 
name and Cisco PCA password.

Step 15 Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
Microsoft Outlook Express does not prompt the user to enter the Connection password. The result is that 
users do not receive voice messages from Connection.

Step 16 Click Next.
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Step 17 On the Congratulations page, click Finish.

Step 18 In the Internet Accounts dialog box, click the account that you created in Step 4, and click Properties.

Step 19 In the <account name> Properties dialog box, click the IMAP tab.

Step 20 Uncheck the Store Special Folders check box.

Step 21 In the Root Folder Path field, enter INBOX (all upper-case letters).

Step 22 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook Express and Connection, skip to Step 25.

Caution If you do not configure Outlook Express to use SSL, the Connection user name and password 
that are sent to Connection over the network and the voice messages sent back from 
Connection are not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook Express and 
Connection, continue with Step 23.

Step 23 Click the Advanced tab.

Step 24 Under Incoming Mail, check the This Server Requires a Secure Connection (SSL) check box.

Step 25 Click OK to close the <account name> Properties dialog box.

Step 26 Click Close to close the Internet Accounts dialog box.

Creating and Configuring an Account in Novell GroupWise
To use GroupWise to access Cisco Unity Connection voice messages, create and configure a new 
GroupWise account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in GroupWise

Step 1 Start GroupWise.

Step 2 On the GroupWise Tools menu, click Accounts > Account Options.

Step 3 In the Accounts dialog box, click Add.

Step 4 In the Create Account dialog box, in the Account Name field, enter a name for the account. This name 
appears only in GroupWise.

Step 5 In the Account Type list, click IMAP4.

Step 6 Click Next.

Step 7 In the Create Internet Account dialog box, in the Incoming Mail Server (IMAP4) field, enter the IP 
address or the fully qualified domain name of the Connection server.
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Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 In the Login Name field, enter the Connection user name.

Step 9 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Step 10 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 11 In the From Name field, enter the user name.

Step 12 Click Next.

Step 13 Follow the on-screen prompts to complete the configuration.

Step 14 If you do not want to encrypt voice messages and other data that are sent over the network between 
GroupWise and Connection, skip to Step 20.

Caution If you do not configure GroupWise to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

If you want to encrypt voice messages and other data that are sent between GroupWise and Connection, 
continue with Step 15.

Step 15 In the Accounts dialog box, click the name of the account that you just created.

Step 16 Click Properties.

Step 17 Click the Advanced tab.

Step 18 Under Incoming Mail Server (IMAP4), check the Use SSL check box.

Step 19 Click OK to close the <Account Name> Properties dialog box.

Step 20 Click Close to close the Accounts dialog box.

Step 21 Create the inbox for the new account, and download Connection voice messages:

a. In the left pane of GroupWise, click the name of the new account.

b. In the Logon to <AccountName> dialog box, enter the PCA password for the user.

c. Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
GroupWise does not prompt the user to enter the Connection password. The result is that users do 
not receive voice messages from Connection.

d. Click OK to close the Logon to <AccountName> dialog box.

e. With the name of the new account still selected in the left pane, on the GroupWise Tools menu, click 
Send/Receive > This Folder.
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Creating and Configuring an Account in Opera
To use Opera to access Cisco Unity Connection voice messages, create and configure a new Opera 
account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Opera

Step 1 Start Opera.

Step 2 On the Opera Tools menu, click Mail and Chat Accounts.

Step 3 In the Manage Accounts dialog box, click New.

Step 4 In the New Account wizard, click IMAP.

Step 5 Click Next.

Step 6 In the Real Name field, enter the account name.

Step 7 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Organization field, enter the applicable value.

Step 9 Click Next.

Step 10 In the Login Name field, enter the Connection user name.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 Click Next. 

Step 13 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 If you want to encrypt voice messages and other data that are sent between Opera and Connection, check 
the Use Secure Connection (TLS) check box. (TLS is an updated version of SSL.)

Caution If you do not configure Opera to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

Step 15 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Step 16 Click Finish.
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Step 17 Click OK to close the Subscribe IMAP Folders dialog box.

Step 18 Click OK to close the Manage Accounts dialog box.

Creating and Configuring an Account in Thunderbird
To use Thunderbird to access Cisco Unity Connection voice messages, create and configure a new 
Thunderbird account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Thunderbird

Step 1 Start Thunderbird.

Step 2 On the Thunderbird File menu, click New > Account.

Step 3 In the Account wizard, on the New Account Setup page, click E-Mail Account.

Step 4 Click Next.

Step 5 On the Identity page, in the Your Name field, enter the user name.

Step 6 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 7 Click Next.

Step 8 On the Server Information page, under Select the Type of Incoming Server You Are Using, click IMAP.

Step 9 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 Click Next.

Step 11 On the User Names page, enter the Connection user name.

Step 12 Click Next.

Step 13 On the Account Name page, enter a name for the account. This name appears only in Thunderbird.

Step 14 Click Next.

Step 15 On the Congratulations page, confirm that the settings are correct, then click Finish.

Step 16 If you do not want to encrypt voice messages and other data that are sent over the network between 
Thunderbird and Connection, you are finished creating and configuring a new account. 
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If you want to encrypt voice messages and other data that are sent between Thunderbird and Connection, 
continue with Step 17.

Step 17 In the left pane of Thunderbird, click the name of the account that you just created.

Step 18 In the right pane of Thunderbird, under Accounts, click View Settings for This Account.

Step 19 In the Account Settings dialog box, under the account that you just created, click Server Settings.

Step 20 Under Server Settings, click the Use Secure Connection (SSL) check box.

Caution If you do not configure Thunderbird to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

Step 21 Click OK to close the Account Settings dialog box.

Creating and Configuring an Account in Windows Mail for 
Windows Vista

Added May 2009
To use Windows Mail for Windows Vista to access Cisco Unity Connection voice messages, create and 
configure a new Windows Mail account for the user. You need the following information:

• Connection user name (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Windows Mail

Step 1 Start Windows Mail.

Step 2 On the Tools menu, click Accounts.

Step 3 In the Internet Accounts dialog box, click Add.

Step 4 On the Select Account Type page, select E-Mail Account.

Step 5 Click Next.

Step 6 On the Your Name page, in the Display Name field, enter the user name.

Step 7 Click Next.

Step 8 On the Internet E-Mail Address page, in the E-Mail Address field, enter the Connection SMTP Address 
of the user and the name of the Connection server. You can find this information in the SMTP Address 
field on the User Basics page in Cisco Unity Connection Administration. The E-Mail Address typically 
follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Click Next.

Step 10 On the Set Up E-Mail Servers page, under Incoming E-Mail Server Type, select IMAP.
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Step 11 In the Incoming Mail (POP3 or IMAP) Server field, enter the IP address or the fully qualified domain 
name of the Connection server.

Caution In Step 11 and Step 12, do not use the fully qualified domain name of the Connection server 
unless DNS is configured for the network.

Step 12 In the Outgoing E-Mail Server (SMTP) Name field, enter the IP address or the fully qualified domain 
name of the Connection server.

Step 13 If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to 
Step 15.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses, 
continue with Step 14.

Step 14 Check the Outgoing Server Requires Authentication check box.

Step 15 Click Next.

Step 16 On the Internet Mail Logon page, enter the user Connection alias and Cisco PCA password.

Step 17 Click Next.

Step 18 On the Congratulations page, click Finish.

Step 19 Click Close to close the Internet Accounts dialog box.

Step 20 If you do not want to encrypt voice messages and other data that are sent over the network between 
Windows Mail and Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Windows Mail and 
Connection, continue with Step 21.

Step 21 On the Tools menu, click Accounts.

Step 22 In the Internet Accounts dialog box, click the name of the mail account that you just created and click 
Properties.

Step 23 In the Properties dialog box, click the Advanced tab.

Step 24 Under both the Outgoing Mail field and the Incoming Mail field, check the This Server Requires a 
Secure Connection (SSL) check box.

Step 25 Click OK.

Caution If you do not configure Windows Mail to use SSL, the Connection username (alias) and 
password that are sent to Connection over the network and the voice messages sent back from 
Connection are not encrypted.

Step 26 Click Close to close the Internet Accounts dialog box.

Troubleshooting IMAP Client Logon Problems
When users change their Cisco PCA password in the Cisco Unity Assistant, they also must update the 
password from their IMAP client application so that the client can continue to access Connection and 
retrieve voice messages.
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If users have trouble receiving voice messages in an IMAP client, consider the following possibilities:

• If the IMAP client application prompts a user for the Cisco PCA password, but does not accept it, 
the Cisco PCA password may have expired or changed, or is locked. Users can change their 
password in the Cisco Unity Assistant first and then update it from their IMAP client application.

• If Microsoft Outlook users are not prompted for their Cisco PCA password, verify that the 
Remember Password check box on the Internet E-mail Settings (IMAP) page is not checked. If this 
option is checked, and the password of the user has expired, changed, or is locked, Microsoft 
Outlook does not prompt the user to enter the Cisco PCA password. The result is that the user does 
not receive voice messages from Connection, and Outlook prompts for the user name and password.
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